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Introduction 

This document describes the execution of HEC-RTS for the Mill Creek, Nashville, 
implementation.  It does not discuss setting up or modifying the implementation; refer to the 
Quick Start Setup guide for that. 

Note: For installing and setting up HEC-RTS for the first time, refer to Appendix A. 
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Execute HEC‐RTS and Load Mill Creek Watershed 

Run HEC-RTS from the exe directory of the HEC-RTS installation or from your shortcut.  The 
main screen will open.  From the Module selector, select Data Acquisition if it is not already 

selected. 

 

 

From the File menu, choose either Open Watershed or select Mill Creek from the list on the 
bottom of the menu. 
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This will display the Mill Creek subbasins and time series icons, and other layers if turned on. 

 

 

If the appropriate layers do not display or are not in the right order, you can turn them on or off 
or change the order from the Layers dialog.  To access the Layers dialog, select Layers from the 

View menu. 
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From the layers dialog, you can select checkboxes to indicate which layers should display, select 
which sub layers should display, such as time series icon layers, or right click on a layer to move 
a layer up or down, or change its properties (e.g., line colors): 
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Data Acquisition 

The Data Acquisition module is used to retrieve real-time data, grid precipitation data from 
gages and review the quality of data retrieved. 

If not already set, set the Time Window to show the past 5 days from the current time.  This only 

controls the display (time series icons). 

 

Press the Get USGS Data Script button in the lower right panel.  This executes a script that uses 

HEC-DSSVue’s Get USGS function to retrieve current real-time data (typically only a few 

minutes old.) 

 

 

Enter the number of days back you need data for.  (If this is the first time the script is run, Jython 
will parse it causing a short delay.) 
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This should have updated the time series icons.  In the Data Acquisition Module, Quality Color 

Bars are shown for each parameter.  Green indicates that there is data present for that time, Black 

indicates missing data and Grey indicates no data.  You can plot, tabulate, show in MS Excel by 
right clicking on a color bar.  You can also show different parameters by changing the selection 
in the Icon Tool Bar at the top of the screen or from the layers dialog.  

 

 

 

 

Now Press the Grid Mill Creek Precip script button in the lower right panel and enter the same 

number of days.  This runs gageInterp to generate 15 minute and 1 hour grid sets.  The 1 hour 

grid sets are used in the display for the Data Visualization module and the 15 minute grid sets are 
used in the modeling computation. 
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Note:  HEC‐RTS and CWMS are inherently setup to display gridded NexRad/MPE precipitation 

from the NWS.  They are not used in the Mill Creek implementation because those grid sets can 

be several hours old and typically data only a few minutes old is important for small watersheds 

such as Mill Creek. 

Select the QPF script button to retrieve QPF data from the NWS.  Note: This data is not directly 

used in the modeling process. 

At this point you should review the quality of the data you have retrieved.  Do you have enough 
to make a reasonable forecast?  Are you missing all?  You may need to investigate by checking 
the USGS NWIS web site for these gages.  You can run HEC-DSSVue and the USGS Data 
Import plug-in and load the station file “C:\NashvilleRTS\Database\Nashville.usgs” to aid in 
your investigation. 

Once you have completed data retrieval, switch to the Data Visualization module. 
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Data Visualization 

The Data Visualization module is used to review the current hydrometeorological conditions of 
the watershed and review the values of the data retrieved.  The Data Visualization module is not 
used to looking at computed or forecasted results. 

 

 

The Data Visualization module displays hourly gridded precipitation and thumbnail plots from 
the gages in and near the basin.  You can select what the thumbnails show by selecting the 
appropriate time series data set from the Layers dialog or Time Series Icon Toolbar. 
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Right clicking on an icon will provide a menu for you to display the data as a plot, table or in 
Excel.  You can also show all the data sets at that location, not just the ones in the layers 
selected. 

 

Some icons have additional features or you can run scripts.  From the Blackman icon, you can 
display a map showing the location of the gage or you can view real time images from a webcam 
nearby. 
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You can review and animate gridded precipitation from the controls in the lower right corner.  
(Note:  Currently the grid color map is set via the program GridUtil.) 

 

Two special time series icons are located in the upper left of the main map screen.  The 
Observed Flow icon shows a plot of flow from all the gages in the basin. 
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In addition to displaying incremental precipitation for all gages, the Observed Precip icon will 

show a plot of cumulative precipitation by right clicking on the icon and selecting Run Plot Cum 

Precip. 

 

 

 

The models use incremental precipitation in their calculations.  However, evaluating 
precipitation is best done using cumulative precipitation.  This will show right away the total 
amounts and differences between gages. 
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Reviewing Data Quality from the Data Visualization Module 

Besides evaluating the current hydrometeorological conditions of the watershed, the Data 
Visualization module is used to look for bad data that could cause poor results in the modeling. 

Precipitation is generally the most important data measured and the most likely to be bad or 
incorrect.  A correct representation of precipitation is vital to producing accurate flows from 
HEC-HMS.  

It is intended that precipitation from gages represent the rainfall in the area of the gage.  
Although a gage could be 100% accurate, if it does not represent what is actually occurring in 
that area, it may cause poor results to be computed from the models.  If other data (e.g., flow 
values) indicates that the gage values are not representative, then you should delete that 
precipitation data. 

Common errors in precipitation include zero values, lower values from windy conditions and 
delayed values typically from debris in the gage.  

If you find bad precipitation data, always delete it, never try to estimate it.  Do not fill in 
missing precipitation data.  When gageInterp is re-run, it will use the other gages in calculating 
the grid for the times that a gage is missing.  If all gages report missing precipitation, then zero 
will be used and you will get a warning message from HMS. 

You can estimate missing or bad flow or stage data, if you desire.  During “blending”, HMS will 
used observed flow to generate the final values.  If flows are missing, they will be replaced with 
computed flow during those time steps. 

 

Fixing Bad Data 

If you determine that gage data is incorrect, then you can either set it missing or estimate from 
the Data Validation Editor in the Data Acquisition module.   

For example, suppose that you discover that the Murfreesboro is reporting zero precipitation, 
while the remaining gages are showing significant rainfall: 
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As you can see in the plot, Murfreesboro’s cumulative precipitation remains at zero during a 
small rain event.  It’s not so much is this an accurate report, but does it represent rainfall for that 
area?  If a nearby gage also showed zero rainfall or a hydrograph of streamflow from that area 
supported this report, then you would run models using the data as is.  However, if there were no 
other supporting factors, then you should “delete” that gage from computation. 

In this version of HEC-RTS, you remove data by deleting that data from the database (a “remove 
gage” function is planned for a future version.)  To do this, switch to the Data Acquisition 
module, select the Murfreesboro time series icon with the precip-inc layer selected, right click 
and select Edit Data. 

 

From the editor, select the entire data set by selecting the top row of the table, go to the bottom 
and press the shift key and left click.  Press the Delete Data button and then the save icon. 
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Do not attempt to estimate precipitation data. 

Since gridded data is used by the models, you must first re-compute the gridded precipitation set. 

 

Switch back to the Data Visualization module and check that your change was made. 



Data Visualization Running HEC-RTS for Mill Creek 

18 

 

 

You can use a similar technique to repair missing or bad flow data if you want by pressing the 
Estimate Data button on the editor.  However, there generally is no need to estimate observed 
flow data and it will probably only be valid for a few missing/bad data values. 

After you have completed reviewing and validating data in the Data Visualization module, 
switch to the Model Interface module to forecast flows and stages. 
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Model Interface 

The Model Interface module is where you run simulation models to forecast flows and stages, 
view inundation maps, and run “what-if?” scenarios.  For Mill Creek, the models run include: 

 MFP – Meteorological Forecast Processor.  MFP grids future precipitation and combines 
with observed precipitation grids. 

 HMS – Hydrologic Model System.  HMS computes flows from the precipitation grid.  In 
a forecast mode, HMS uses observed flows up to the time of forecast, then “blends” 
future flows to produce hydrographs. 

 RAS – River Analysis System.  RAS computes stages from HMS’s hydrographs and river 
cross sections. 

 RAS Mapper.  RAS Mapper uses the results from RAS and computes inundation depths 
and boundaries. 

 

 

Before modeling begins, the user selects a “Forecast Time”.  This a time where all data before 
that time is observed or known and all data after that time is computed.  This time is used to 
create a directory that will contain all data and model input files needed.  Time series and 
gridded data are extracted into a “forecast.dss” file in that directory. 

The time zone, set under the View menu, should be set to local.  Although data viewed from 
RTS will be for the local time zone, the models will run in “Watershed Time”, which is local 
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time without Daylight Savings time.  The models are not programmed to handle the hour change 
for Daylight Savings time. 

Modeling Step 1:  Create a “Forecast” 

Determine your forecast time by looking at available data.  Forecast times are on the hour.  Most 
probably, you’ll choose the last hour boundary, which is the default.  From the Forecast menu, 

select New. 

 

 

 

 

Check which scenarios or Alternatives you want to run (you don’t need to run them all and you 
can select more once you are in a forecast.)  “No Future Rain” is always selected for calibrating 
the HMS model, unless you don’t need to calibrate it because you just did.  “User Specified” 
indicates that you’ll choose a future rainfall amount and temporal distribution. 
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When you create a forecast, all of the models selected, and all related files are copied to a new 
directory that contains the forecast time and basin name.  In this example, the forecast directory 
is: 

C:\NashvilleRTS\Watershed\2012.04.13‐1500\Mill_Creek 

If you run into any issues, go to this directory for all input files and output files. 

 

 

 

In the right hand panel, right-click on “No Future Rain” alternative and select Set As Active,  

Note:  a majority of model commands are available from right clicking on the alternative. This 

will load all modeling components for that alternative into RTS, and make those modeling 
components the ones that are edited.  If a model (e.g., HMS) is shared between forecast 
alternatives, then changes to it will be made to all forecast alternatives. 

Note – Nomenclature: 

 Model Alternative:  The files associated with a “single” model run.  For example, MFP 

with no future rainfall is one model alternative and MFP with two inches is another. 
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 Forecast Alternative:  The concatenation of a set of model alternatives.  For example, 

Two inch MFP along with Base HMS and Steady RAS make up a single forecast 

alternative. 

 

 

Modeling Step 2:  Calibrate HMS 

With the No Future Rain alternative selected, from the Forecast menu, select Compute ‐> HMS.  
You can also right click on the alternative name to compute. 
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This will run both MFP with no future rain and HMS. 

 

 

Review the “Observed” verses computed results from HMS by selecting the menu Reports ‐> 

HMS ‐> Results ‐> No Future Rainfall‐Base.   

 

 

This will bring up a dialog similar to the following: 
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For this time frame, there was no significant precipitation and little to calibrate to.  The base flow 
is significantly off.  We can, and will, adjust it, but we cannot determine a good estimate of soil 
moisture from the plot; for that we’ll need experience.  However, the plot shows that we’re not in 
an event, so the results for this time are probably not as important.  If we had a rising 
hydrograph, we could do a much better job of estimating soil moisture parameters. 

Note:  The HMS model has been calibrated for more of an event mode.  As such, runs during 

lower flow periods should not be expect to be close without parameter adjustment.  Refer to 

discussions on parameters and calibrations relative to seasons and conditions. 

To adjust HMS parameters, or calibrate it to current conditions, select from the Edit menu, 

Models ‐> HMS 
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This brings up the HMS dialog: 

 

 

From this dialog, we will set any HMS parameters that are typically modified during real-time 
simulation.  Note:  the next release will include a graphical calibration (slider bar) function. 

Usually the most common parameter that we would adjust would be the Loss Rates.  If we were 
expecting significant rainfall, we would adjust them to the best of our ability according to our 
experience with this basin.  For right now, we’ll only adjust baseflow.  Since the computed 
baseflow is about 2 times more than observed, we’ll divide the discharge per square mile by 1/2.  
That’s the first white box after 1.0.  Also, our curve is a little steep, so we’ll try a coefficient of 
80 (100 is horizontal).  The remaining parameters are for more ground water sub-layers, which 
this model does not have. 
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This is probably good enough, depending on our objectives.  If we tweak the coefficient a little 
more, we end up with the following plot. 

 

This is relatively good, considering this is an event oriented model.  We could modify the ground 
water component in the model to contain another sub-layer so that the curves match, but it 
wouldn’t have much impact during high flows.  If we wanted to keep our calibration for the next 
forecast, we’d “Save HMS to base”, generally a good idea. 

 

Soil moisture parameters, which usually have the greatest impact, can be calibrated after an 
“event” has started.  Typically, we’ll adjust the parameters on the rising limb of the hydrograph, 
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where we begin to see an increase in flow.  For example, if we are at 1800 on 08Mar2012, our 
hydrograph at Woodbine looks like the following: 

 

 

 

This is usually where we need to forecast, and we often have significant data to adequately adjust 
the soil moisture parameters.  As we continue into the event, we can refine them further, if 
needed. 
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This is a significant hydrograph just from the rain that has already fallen, but if we zoom in we 
see that the computed flows are higher than the observed, meaning that the soil is dryer than 
what the model is set to. 

 

 

We will increase the initial loss and constant loss to bring the two curves in line.  If they match, 
then we’ll consider the model reasonably calibrated. 
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We can continue to adjust the loss rates to bring the computed curve closer together.  The 
information in the bottom of the table provides some comparison information.  In the above plot, 
we would only have flow up to 1800, the time of forecast.  At that time, it looks like were 
actually have our loss rates set too high. 

Before you adjust loss rates too much, you need to keep in mind what is reasonable and what 
else may be going on.  Is the precipitation accurate?  Was more computed than actually fell?  Are 
there changes in the watershed?  Are there other parameters that should be adjusted?  Refer to 
the discussion on calibration. 

 

Modeling Step 3:  Blending 

Once HMS has been calibrated to current conditions, you will use HMS to forecast flows.  The 
first step is to turn on Blending.  Blending is where HMS takes observed flows and uses them in 

place of computed flows, wherever they are available.  This significantly improves the results; in 
fact if there were no future rain and sufficient time had past so that the upstream peak had been 
measured, then HMS will mainly do routing.  
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The following plot is for the same location and time as the previous plot.  Notice that the 
computed and observed flows match. 

 

 

Blending is turned on from the HMS forecast dialog by selecting the blend method Taper and 
setting a taper time of about 3 hours. 
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Modeling Step 4:  Forecasting Flows 

Generally, one will look at HMS’s results for the No Future Rain alternative as a base.  HMS 
computes both flow and stage hydrographs. 

Note:  HMS uses hydrologic routing to compute stage hydrographs.  RAS uses “hydraulic” 

routing (which takes into account things like bridges, etc.), which should be more accurate.  For 

Mill Creek, “Steady flow” routing is computed; “Unsteady flow” routing, which accounts for the 

wave aspects of the hydrograph, would be more accurate.  However, such a model is relatively 

complex and subject to instability, and the potential errors compared to steady flow are 

substantially less than errors from measured and forecasted rainfall. 

You can review flow and stage hydrographs by turning “computed” time series icons on, and 
selecting Flow or Stage from the Results menu. 
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By selecting the Time Series Icon mouse tool on the left panel, you can double click on a thumb 
nail to produce a plot. 
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Modeling Step 5:  Forecasting Flows with Forecasted Rain 

After you have completed an initial forecast with no future rain, you can forecast flows with 
forecasted rain and rain scenarios.  Generally, one would first forecast with the QPF (Quantitive     
Precipitation Forecast) and then potential scenarios.   

Future rain is entered in the MFP precipitation dialog.  Set the appropriate Forecast Alternative 

as Active.  Then bring up the MFP dialog by selecting from the Edit menu Models ‐> MFP.  

Uncheck the No Future Rainfall alternative, as you won’t be comparing these alternatives right 
now. 
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You can type in values in the table, or enter one value, select the rows to set, right click and 
choose Fill…   From the Fill dialog, you can repeat the first value or choose an alternative 
method.  The values identify both the amount and temporal pattern. 

      

 

You can also specify rainfall using the Graphical Editor.  To use the Graphical Editor, enter the 
total volume, as a single number, at the end of the rainfall time.  For our example, we’ll be 
entering 5 inches over 4 hours, so that we can generate sufficient flows to illustrate the depth grid 
later. 
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In the MFP dialog, enter the number 5 at +4 hrs 00 min:  Then Press the Graphical Edit button. 

 

    

 

 

The Graphical Editor edits total or cumulative rain verses time; we are using it mainly to indicate 

the temporal distribution of forecasted rain.  For cumulative rain, the curve must continue to 
increase (you cannot have negative rainfall).  If your curve goes down, it will adjust values to the 
last good value. 

Select the line draw mouse tool, the lowest box in the vertical tool bar on the left.   



Running HEC-RTS for Mill Creek Model Interface 

37 

 

Left click on your first data point, then move right left-clicking on points where you want the 
graph to change.  All points in-between will be linearly interpolated.  Be sure to keep the curve 
increasing.  When you are complete, right-click to establish your end point.  Your final point 
should end up on at the total value (in this example, 5 inches at 22:00).  You can modify you 
curve or press the Accept All button.  You can still change your curve after you press the Accept 
All button, but make sure you have pressed it after all of your changes. 
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If you press the graph button on the top left, you will get a plot of the incremental precipitation. 

 

 

Press the Save button in the upper left to send your data back to the MFP dialog. 

 

 

You can continue to change the table or press the graphical edit button until you are satisfied 
with your future rainfall.  When you are finished, press the OK button on the MFP dialog. 

Compute your future flows by running HMS. 
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Review the results from either the HMS Reports dialog, Plots from thumbnail icons or from 
selecting Flows/Stages from the Results menu. 

Note:  The checkbox for the forecast alternatives on the right panel indicate which results will be 

displayed together (for comparison).  The bold forecast alternative indicates which models are 

currently loaded into RTS and that you are editing. 

 

 

Results Displayed 

Results Displayed and Loaded into RTS 

Results Not Displayed 
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Note:  Values are extreme to illustrate inundation depths later. 
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Modeling Step 6:  Forecasting Stages with RAS  

A steady-state RAS model is used to compute stages and inundation depths for Mill Creek. 

Before you run RAS, you should adjust Manning’s n values (waterway friction or resistance) due 
to seasonal or other changes, and select which inundation calculations you want RAS to do, if 
any.  To adjust RAS parameters, select the Edit menu, then Models ‐> RAS. 

 

 

 

 

 

Pressing Manning’s n button gives the following dialog, where you can adjust N values for the 
main channels and overbanks.  Generally, during spring and summer, vegetation increases in the 
creek areas which require an increase in n values.  Refer to the discussion on Manning’s n for 
more information. 
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If you might want to view inundation depths or boundaries, check the checkbox Compute Peak 

Flow Profile.  Although profiles at different time intervals could be computed, that function takes 
significant compute time and is generally not as useful as examining the peak and using the HMS 
stage computations for timing.  Do not select the GIS – Compute Inundation checkbox, as that 
method has been replaced by RAS Mapper.  Also, do not select the Flow Data button, as that is 
used for setup. 

Now run RAS by pressing the Compute (User Specified) button below the right side forecast 

alternatives panel. 

Note:  Do not run RAS when you may have very low flows, as if the RAS compute will fail if it 

tries to compute with a zero flow value. 

If you do encounter a low flow RAS error, which can occur when you have missing precipitation 
(all missing is counted as zero) or dry conditions, then setup your upstream basins to have a 
minimum of 2 cfs of baseflow.  
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You can plot the water surface profile for a stream by (zooming in), selecting the stream, right 
clicking on it and then select Plot Water Surface Profile. 

 

 



Running HEC-RTS for Mill Creek Model Interface 

45 

 

 

The RAS stage (profile) table output is displayed by RAS Profile Table from the Reports menu. 
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Modeling Step 7:  Computing and Viewing Inundation Depths 

RAS Mapper uses data computed by RAS and detailed Digital Elevation Model (DEM) to 
compute an inundation boundary map and inundation depth grids.  In the current version, several 
manual steps are need to create these maps; the next version will have most of these steps 
automated. 

After running RAS from RTS, with the forecast alternative set as active, open the RAS GUI by 
selecting the RAS icon at the top of RTS: 

 

 

 

 

From the RAS menu GIS Tools, select RAS Mapper. 

 

 

This displays the main RAS Mapper screen, showing a depiction of the Mill Creek RAS model 
in the right hand panel. 
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From the Tools menu, select Floodplain Mapping… 

 

 

 

This displays the Floodplain Mapping dialog where the Terrain DEM is selected and the 
inundation layers are computed. 
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To specify the DEM, select the button New Terrain….  and choose the millcreek.flt file. 
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Accept the default layer name (Terrain) 

 

 

Select Terrain from the Ground Surface Terrain Layer pull-down.  Now check the checkboxes 
PEAK_FLOWS and Water Surface Elevation. 
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Press the Generate layers button at the bottom.  RAS Mapper will start the process of computing 
the depth and boundary layers.  This computation will take several minutes. 

 



Running HEC-RTS for Mill Creek Model Interface 

51 

 

 

 

 

The computations produce both a inundation shape file and depth grid file in the directory 

 …Mill_Creek\ras\Steady hyd rout dev\PEAK_FLOWS 



Model Interface Running HEC-RTS for Mill Creek 

52 

 

 

Those results may be displayed by RTS by selecting Show RAS Inundation Depths or Show RAS 

Inundation Boundary from the Results Menu 

 

 

Typically a MrSid background image is displayed with the results.  Press the Show Aerial 

Background button in the lower right of the screen to load this image. 
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You’ll need to zoom in to see the results.  Choose the Magnifying Glass tool from the tool bar, 
position your mouse over the area of interest and draw a square to zoom into by holding down 
the mouse key while  you move the magnifying glass. 

 

 



Model Interface Running HEC-RTS for Mill Creek 

54 

 

 

You can zoom and pan to specific areas of interest.  Select the default cursor (the arrow) and 
hover over a depth grid cell to show the water dept for that cell for the peak inundation. 
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You can also turn on the Streets shape file from the Layers Dialog to display streets and street 
names. 
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You can control the colors, transparency, etc., from the properties dialog by right clicking on the 
Depth0.flt layer in the layers dialog. 
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The inundation boundary can be displayed by removing the depth layer and then selecting the 
boundary layer from the Results menu.  This first displays the Shape file properties dialog so that 
you can set the fill color and transparency level. 
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Appendix A.  Installation 

Note:  Before you begin, you must install HEC‐RAS with the normal RAS install package, 

available from the HEC Website.  RAS set several registry entries that are needed for it to run. 

Unzip the three zip files to C:\on your hard disk.  All software needed is included in this package 
– you do not need to install Java, HMS or other programs.  2.7 GB of hard disk space is required. 

 

 

 

 

It is recommended that you make a short cut to your desktop for HEC-RTS, HEC-HMS and 
HEC-RAS.  These program executables are in the package “exe” directory.  Note:  There is an 
hms.exe and hmsCwms.exe.  hms.exe is the standard distribution version of CWMS and 
hmsCwms.exe is a special CWMS version.  Use the standard hm.exe version. 
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Setup 

HEC-RTS needs a “home directory” (also labeled as CWMS_HOME) to store configurations, 
etc.  RTS also requires a “watershed” directory where you store and use your watershed files, 
models, data, etc.  We recommend that these directories be the same.  (You may have multiple 
watershed directories if desired, but only one home directory.)   When you first start HEC-RTS it 
will ask you for this directory: 

 

 

Select “C:|\NashvilleRTS”. 

 

 

Agree to the terms. 
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The C of RTS will open.  You should be able to go the menu File and select Open Watershed 
and select Mill_Creek.  If the Mill Creek Watershed does not appear, go to the Tools menu and 
selection Options… 
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Select Add Location… and Browse to C:\NashvilleRTS\Watershed 

 

 

 

 

Now select Mill_Creek from the Open Watershed menu. 

 

 


